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LESSON 1 -  
USING TABLES  

In this lesson, you will learn how to: 

• Create a PowerPoint table  

• Insert a Word table  

• Edit a Word table  

• Use Table AutoFormat  

• Work with user-defined table styles  

• Adjust table cells  

• Select rows and columns  

• Insert rows and columns  

• Link a Word table  
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CREATING A POWERPOINT TABLE 

 Discussion 
Tables can be used to present information organized into columns and rows. You 
might want to insert a table, for example, to illustrate regional sales figures that do not 
need to be graphed. 
 
There are two types of tables you can insert into a PowerPoint slide; you can insert a 
simple PowerPoint table, or you can insert a Microsoft Word table. A Microsoft Word 
table offers more formatting features than a PowerPoint table. 
 
The simplest way to insert a PowerPoint table is to click a table placeholder. When 
you create a simple table, you must choose the desired number of rows and columns. 
When the table appears in the slide, all cells are perfectly symmetrical. You can, 
however, resize them manually as needed. 
 
You can also create a more complex table that contains either cells of different heights 
or a random number of columns per row. Complex tables are generally created using 
the Draw Table button on the Tables and Borders toolbar. The Draw Table button 
allows you to create a table freehand, without having to follow the conventions of a 
simple table. 

 
Creating a PowerPoint table 
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You can create a simple PowerPoint table by inserting a new 
slide with a Title and Table layout or by applying any slide 
layout that contains a table placeholder. 

  

 
You can also insert a table by selecting the Insert menu and 
the Table command, or you can click the Insert Table button 
on the Standard toolbar and drag in the grid as desired. 

  

 
If some table borders disappear when you are entering text 
into the table, you can try refreshing the screen by selecting 
100% from the Zoom list on the Standard toolbar and then 
returning the zoom level to Fit. 

  
 

 Procedures 

1. Double-click the Double click to add table placeholder. 

2. Enter the desired number of columns in the Number of columns 
box. 

3. Enter the desired number of rows in the Number of rows box. 

4. Select OK. 

 

INSERTING A WORD TABLE 

 Discussion 
When you insert a Word table, a Word object is embedded on the slide and Word is 
automatically activated. You use the Insert Object dialog box to insert the Word 
object and then use the available Word menus and toolbars to insert a Word table into 
the embedded object. In addition to selecting the number of rows and columns you 
want in the table, you can choose one of three available AutoFit settings, as well as 
apply a table style. Finally, you can set the selected options as the default for all future 
tables. 
 
The cells in a table, which act as placeholders for the table data, can appear as either 
numbers or text. When you enter data into the table cells, you use Word insertion and 
navigation techniques, and the data appears in the embedded Word table, not directly 
on the PowerPoint slide. You can move from cell to cell using the mouse or the [Tab] 
and arrow keys. You also use Word procedures to format the table. 
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In order to insert a Microsoft Word table, you must have Microsoft Word installed on 
your system. 

 
Inserting a Word table 

 
  

 
You must activate Microsoft Word to edit or format the 
embedded object. To activate Word, double-click the 
embedded Word object. 

  

 
You can use the Tables and Borders toolbar to format either 
a PowerPoint or Microsoft Word table. Most of the table 
formatting tools are available for either type of table. 

  

 
PowerPoint and embedded Word tables display cell borders by 
default. 

  
 

 Procedures 

1. Display the slide on which you want to insert a Microsoft Word 
table. 

2. Select the Insert menu. 

3. Select the Object command. 

4. Select the Microsoft Word Document object type. 

5. Select OK. 
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6. Select the Table menu. 

7. Point to the Insert command. 

8. Select the Table command. 

9. Enter the desired number of columns in the Number of columns 
box. 

10. Enter the desired number of rows in the Number of rows box. 

11. Select the desired AutoFit behavior option. 

12. Select OK. 

 

EDITING A WORD TABLE 

 Discussion 
You can edit an embedded Word object. For example, you may want to edit the data 
or add row headings to the Word table to explain the data. 
 
Since a Word table inserted in PowerPoint is an embedded object, you must activate 
Word to edit the table. 
 

  

 
To edit an embedded object, you can also right-click the 
embedded object, point to the Document Object command, 
and then select the Edit command. 

  
 

 Procedures 

1. Double-click the embedded Word object to activate Word within 
PowerPoint. 

2. Make the desired changes. 
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USING TABLE AUTOFORMAT 

 Discussion 
You use Word procedures to format a Word table embedded in PowerPoint. The 
Tables and Borders toolbar provides tools for drawing and erasing tables, selecting 
line style and weight, setting border color and position, and choosing fill colors. This 
toolbar also provides tools for merging and splitting table cells, aligning cells, 
distributing rows and columns evenly, formatting the table automatically, changing 
the text direction of the cell contents, sorting cells, and summing data. 
 
In addition, the Tables and Borders toolbar includes the Table AutoFormat feature, 
which you can use to apply predefined formats to an entire table or to selected table 
components. This feature only applies to a Word table; it is not available for a 
PowerPoint table. 
 
The Table AutoFormat feature allows you to choose from many combinations of 
shading and borders, which can make a table easier to view in addition to adding a 
more finished, professional look. The Table AutoFormat feature allows you to select 
the table components you want to AutoFormat, as well as remove table formatting. In 
addition, you can modify or delete existing Table AutoFormat styles, or create your 
own table styles. You can also set a particular table style as the default for all 
embedded Word tables. 
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The Table AutoFormat dialog box 

 
  

 
You can also select the Table menu and then the Table 
AutoFormat command to open the Table AutoFormat dialog 
box.  

  

 
You can bisect a table cell with a diagonal line and position 
text or graphics in either one or both halves of the cell. A 
diagonal line can be created by enabling the Draw Table 
button on the Tables and Borders toolbar and dragging to 
draw the diagonal line in the cell or by selecting one of the 
diagonal styles from the Borders button on the Tables and 
Borders toolbar. 

  

 
You can apply an AutoFormat when you are creating the 
Word table by selecting the AutoFormat button in the Word 
Insert Table dialog box. 
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 Procedures 

1. Double-click the embedded Word object. 

2. Click in the Word table, if necessary. 

3. Click the Tables and Borders button  on the Standard 
toolbar. 

4. Click the Table AutoFormat button  on the Tables and 
Borders toolbar. 

5. Select the Category list. 

6. Select the desired category. 

7. Select the desired style from the Table styles list box. 

8. Select or deselect AutoFormat options as desired. 

9. Select Apply. 

 

WORKING WITH USER-DEFINED TABLE STYLES 

 Discussion 
You can use the Table AutoFormat feature to apply custom styles to a table when the 
existing styles do not fit your needs. 
 
In addition to selecting the existing formatting elements you want to apply in the 
Table AutoFormat dialog box, you can also modify any available style to better suit 
your needs. In the Modify Style dialog box, you can change text and table cell 
formatting, as well as table properties and paragraph and tab settings. By default, 
when you use the Table AutoFormat feature to format tables, table row heights are 
resized to fit their contents. 
 
If you frequently format tables in the same manner, you can save your table formats 
by creating new table styles. You can set different formatting for each part of a table, 
if desired. For example, you can format the table header row with a specific fill color 
and font style, and then format the rest of the table with a different fill color and 
perhaps a stylish border. When you create new table styles, they are added to both the 
User-defined table styles and All table styles categories in the Table AutoFormat 
dialog box and are then available to be applied to future tables. If you delete a table 
style, however, the formatting of the deleted table style will be removed from any 
table to which it was applied. 
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After a Table AutoFormat has been applied, you can modify or remove its formatting 
as desired. You can also remove table formats by selecting the Table Normal style 
from the Table AutoFormat dialog box. When you apply the Table Normal style, all 
table formatting is removed from the table. 

 
Creating a table style 

 
  

 
You can also select the Table menu and then the Table 
AutoFormat command to open the Table AutoFormat dialog 
box.  

  

 
You can modify an existing table style by selecting the 
Modify button in the Table AutoFormat dialog box. 

  
 

  

 
Selecting the Delete button in the Table AutoFormat dialog 
box deletes user-defined table styles from the Table 
AutoFormat dialog box. 
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 Procedures 

1. Double-click the embedded Word object you want to format. 

2. Click the Tables and Borders button  on the Standard 
toolbar. 

3. Click the Table AutoFormat button  on the Tables and 
Borders toolbar. 

4. Select New. 

5. Enter the desired table style name in the Name box. 

6. Select the Style based on list. 

7. Select the table style on which you want to base your new table style. 

8. Under Formatting, select or deselect options as desired. 

9. Select OK. 

10. Select Apply. 

 

ADJUSTING TABLE CELLS 

 Discussion 
When you first create a Word table, the columns are a fixed width by default. As you 
enter data into the table, you may find that some columns need to be narrower than the 
default width and others need to be wider. 
 
You can quickly adjust the width of any table column by dragging its column border 
to the desired width. You can adjust as many columns in a table as desired, although 
adjusting the width of any one column (except the last) does not affect the overall 
width of the table. 
 
If all the cells in a column are the same width, the width of the entire column changes. 
If the cells within the column are different widths, however, only the width of the 
current cell changes. 
 
Row height automatically adjusts to fit the font size or the number of lines of wrapped 
text within a row. If you want to add more spacing above or below the text in a row, 
you can change row height by dragging the row border to the desired height. You can 
only adjust the height of one row at a time by dragging. 
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If you hold the [Alt] key as you drag a column or row border, 
the exact column or row measurement appears on the 
corresponding ruler. 

  

 
You can also change column width by dragging the table 
column markers on the Word horizontal ruler, or you can 
change row height by dragging the table row markers on the 
Word vertical ruler. If you need precise measurements, you 
can access the Row or Column page in the Table Properties 
dialog box. 

  
 

 Procedures 

1. Double-click the embedded Word table you want to edit. 

2. Drag any row header border up to decrease or down to increase the 
height of that row. 

3. Drag any column border to the left to decrease or to the right to 
increase the width of that column. 

 

SELECTING ROWS AND COLUMNS 

 Discussion 
Before you can perform many actions on table columns or rows, you must first select 
the rows or columns you want to modify. You can use the Select submenu on the 
Table menu to select the entire table, the entire column or row relative to the insertion 
point or current selection, or just the current cell. You can select single or multiple 
columns or rows. 
 

  

 
You can also drag across a row or down a column to select it 
or drag to select multiple cells, rows, or columns. 

  

 
You can select text in an embedded Word table in the same 
way you would select text in any other presentation object. 
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 Procedures 

1. Double-click the embedded Word object. 

 2. Click any cell in the row or column you want to select. 

3. Select the Table menu. 

4. Point to the Select command. 

5. Select the desired command. 

 

INSERTING ROWS AND COLUMNS 

 Discussion 
When you create a table, you can designate the desired number of rows and columns. 
If you need to add additional information to an existing table, you do not need to re-
create the table. Instead, you can insert new rows or columns into the current table. 
 
You can insert a row above or below the current row or a column to the left or right of 
the current column. You can also add multiple rows or columns by first selecting the 
same number of rows or columns you want to add and then inserting the rows or 
columns. 

 
Inserting a row above 
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You can also use the Draw Table tool on the Tables and 
Borders toolbar to draw columns and rows in a table. You can 
split a table cell with a diagonal border line by drawing the 
line with the Draw Table tool or by selecting one of the 
diagonal border styles from the Borders list. 

  

 
You can also insert rows and columns by selecting the Table 
menu, pointing to the Insert command, and selecting the 
applicable command. In addition, you can add a row to the end 
of a table by clicking in the last cell of the table and pressing 
the [Tab] key. 

  

 
You can insert multiple rows or columns by first selecting the 
desired number of rows or columns you want to add to the 
existing table, selecting the Table menu, pointing to the Insert 
command, and selecting the applicable command. 

  
 

 Procedures 

1. Double-click the embedded Word object. 

2. Select the row above which or the column to the left of which you 
want to insert the new row or column. 

3. Click the arrow on the Insert Table button  on the Tables 
and Borders toolbar. 

4. Select the applicable Insert Rows or Insert Columns command. 

 

LINKING A WORD TABLE 

 Discussion 
In addition to inserting a Word table as an object, you can also copy and paste a Word 
table into your presentation as a linked object. When you copy the Word table, any 
formatting that has been applied is copied as well as the table contents. When you 
subsequently paste the table, an exact copy of both the contents and formatting is 
pasted. 
 
Changes to a linked table are made in Word and immediately updated on the 
PowerPoint slide, if the presentation is open. If you make changes to a linked Word 
table while the PowerPoint presentation is closed, however, a message box appears as 
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soon as you open the PowerPoint file, informing you that the presentation contains 
links that can be updated. You can update the links at that time or at any later time 
while you are working in the presentation. 

 
Pasting a linked table 

 
  

 
You can double-click a linked table to open it in Word. 

  

 
You can also open a linked table in Word by right-clicking the 
table, pointing to the Linked Document Object command, 
and selecting the Edit or Open command. 

  
 

  

 
The Word file containing the source table must be open in 
order to paste the table as a link. 

  
 

 Procedures 

1. In Word, select and copy the table you want to link. 

2. Go to the PowerPoint slide on which you want to paste the linked 
table. 

3. Select the Edit menu. 

4. Select the Paste Special command. 

5. Select the Paste link option. 

6. Select the link type you want to use. 

7. Select OK. 

 



 

 

LESSON 2 -  
CREATING BASIC CHARTS  

In this lesson, you will learn how to: 

• Use charts in presentations  

• Create a chart  

• Delete data from the datasheet  

• Enter data into the datasheet  

• Change the chart type  
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USING CHARTS IN PRESENTATIONS 

 Discussion 
PowerPoint’s built-in graphing application, Microsoft Graph, allows you to 
incorporate charts into your presentations without having to import them from other 
applications. When you create or edit a chart in PowerPoint, the Microsoft Graph 
menu bar, toolbar, and datasheet appear. Microsoft Graph also provides several chart 
types from which you can choose. 

 
The datasheet displays the values depicted in the chart and is composed of rows and 
columns. The intersection of a row and a column is called a cell. You can type the 
chart data directly into the cells, as well as add or delete rows and columns to or from 
the datasheet as needed. 
 
The Microsoft Graph charting module allows you to group any time-based charts by 
month or year in order to view the appropriate level of detail for the included time 
analysis. It also allows you to add explanations to charts to enhance your 
presentations. With the charting module, you can scale fonts and rotate text along the 
chart axes. In addition, you can add textures, imported pictures, or gradient fills to 
chart elements. You can also add animation to certain chart elements. 

 
The Microsoft Graph interface 

 
  

 
You can also insert a Microsoft Excel chart directly onto a 
PowerPoint slide. 
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In order to create smaller files, PowerPoint automatically 
compresses graphics and files. 

  
 

CREATING A CHART 

 Discussion 
When you want to include a chart on a slide, you usually select a slide layout 
containing a chart placeholder. For example, you can select the Title, Text and 
Chart, the Title, Chart and Text, or the Title and Chart layout. You can also place 
a chart on any slide layout. 
 
Once you have created the chart, a datasheet appears in which you enter the values 
you want to graph. By default, PowerPoint inserts sample data into the datasheet. 

 
Creating a chart 

 
  

 
To create a chart on a slide that does not have a chart 
placeholder, you can use the Insert Chart button on the 
Standard toolbar, or you can select the Insert menu and then 
the Chart command. 
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 Procedures 

1. Create or display a slide that contains a chart placeholder. 

2. Double-click the chart placeholder on the slide. 

 

DELETING DATA FROM THE DATASHEET 

 Discussion 
By default, PowerPoint inserts sample values into the datasheet. You can delete data 
from individual cells, groups of cells, or entire rows or columns. To remove data from 
entire rows or columns, you must first select the row or column heading. For example, 
if you want to remove the first quarter sales figures in row 1, you must select the row 
1 heading and then delete the data. If you delete the information in a row or column 
without first selecting the row or column heading, the data is removed, but the row or 
column remains in the datasheet. 
 

  

 
To select all the data on a datasheet, click the Select All button 
(the gray rectangle in the upper left corner of the datasheet, 
where the column and row headings meet). 

  

 
You can also delete data from multiple, adjacent rows or 
columns by dragging to select the desired row or column 
headings. 

  
 

 Procedures 

1. Open the datasheet from which you want to delete data. 

2. Select the cells containing the data you want to delete. 

3. Press [Delete]. 
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ENTERING DATA INTO THE DATASHEET 

 Discussion 
You can enter both text and numeric data into a cell in the datasheet. The data entered 
into the first column, which is normally text, becomes the legend data for the chart. 
The data entered into the other cells is used for developing the chart. For example, the 
first column might contain the headings Region 1, Region 2, and Region 3, and the 
data entered into the other cells would reflect the actual data for each region. 
 
When you have finished editing chart data, you can close the datasheet, which allows 
you to view the entire chart. 
 

  

 
You can press the [Tab] key to advance to the next cell. 

  

 
Once you have closed the datasheet, it no longer opens 
automatically when you double-click the chart. To view the 
datasheet, click the View Datasheet button on the Microsoft 
Graph Standard toolbar, or select the View menu and then the 
Datasheet command. 

  
 

 Procedures 

1. Open the datasheet. 

2. Select the cell you want to edit. 

3. Enter the desired data into the cell. 

4. Press [Enter]. 

5. Continue entering data as desired. 

6. When you have finished entering data, click the Close button on the 
datasheet window title bar. 
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CHANGING THE CHART TYPE 

 Discussion 
You can change the chart type of an existing chart. PowerPoint offers several different 
chart types, as well as multiple variations of each. Changing the chart type allows you 
to select the best chart type for your data. For example, if you want to chart data in 
bars, you can select a Bar chart type in any of six variations, including Clustered 
Bar, Stacked Bar, or Clustered bar with a 3-D visual effect. 

 
Selecting another chart type 

 
  

 
To preview the chart type, hold the Press and Hold to View 
Sample button in the Chart Type dialog box. A preview of the 
chart with the selected type applied appears under Sample. 

  
 

 Procedures 

1. Double-click the chart you want to edit. 

2. Select the Chart menu. 

3. Select the Chart Type command. 
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4.  Select the Standard Types tab. 

5. Select the desired chart type from the Chart type list box. 

6. Select the desired chart sub-type. 

7. Select OK. 

 



 

 

LESSON 3 -  
EDITING AND IMPORTING CHARTS  

In this lesson, you will learn how to: 

• Edit charts  

• Format the chart data markers  

• Reposition the legend  

• Format the 3-D view of a chart  

• Drag to adjust a 3-D chart  

• Explode a pie chart  

• Select chart options  

• Import an Excel chart  
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EDITING CHARTS 

 Discussion 
PowerPoint uses an application called Microsoft Graph to create and edit charts. 
Microsoft Graph is the charting module used by PowerPoint and other Office 
applications. Microsoft Graph provides traditional chart types, such as bar, column, 
line, area, and scatter. In addition, it provides some less common chart types, such as 
bubble, pie of pie, bar of pie, cylinder, pyramid, and cone. Microsoft Graph provides a 
variety of 3-D chart types as well. 
 
In order to edit a chart, you must activate Microsoft Graph. Once Microsoft Graph has 
been activated, the Microsoft Graph menu and toolbars replace the PowerPoint menu 
and toolbars. 
 
You can edit the entire chart area, the plot area, or individual chart objects (such as 
gridlines and axes). The available menu items, toolbar buttons, and editing options 
depend upon which object is selected. For example, if you select a chart data marker, 
the Format button on the Microsoft Graph Standard toolbar becomes the Format 
Data Series button. If you select a chart axis, the button becomes the Format Axis 
button. In appearance, the button stays the same; however, the button name and the 
dialog box that opens when the button is clicked change, depending on the selected 
chart object. 
 

  

 
A ScreenTip appears when you point to any chart object in 
Microsoft Graph; ScreenTips can help you select the correct 
chart object. 

  
 

FORMATTING THE CHART DATA MARKERS 

 Discussion 
Data markers are the bars, pie slices, lines, etc., that graphically display the chart data. 
You can fill the data markers with colors, textures, patterns, pictures, or gradient 
(shaded) fills. For example, you can format each of the “slices” in a pie chart and 
display data labels, values, or percents, if applicable. You can also choose to display 
the legend next to the data label. 
 
Before you can format the chart data markers, you must activate Microsoft Graph. 
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Formatting data markers 

 
  

 
You can also double-click any data marker to open the Format 
Data Series dialog box.  

  

 
You can also use the Drawing toolbar to change chart fill 
colors and effects in Microsoft Graph. 

  
 

 Procedures 

1. Double-click the chart you want to edit. 

2. Click the View Datasheet button  to close the datasheet, if 
necessary. 

3. Select the data marker you want to edit. 

4. Click the Format Data Series button . 

5. Select the Patterns tab. 

6. Under Area, select the desired fill color. 

7. Select Fill Effects. 

8. Select the Gradient tab. 
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9. Under Colors, select the desired color option. 

10. Under Shading styles, select the desired shading style. 

11. Under Variants, select the desired effect. 

12. Select OK. 

13. Select the Data Labels tab. 

14. Under Data Labels, select the desired option. 

15. Select OK. 

 

REPOSITIONING THE LEGEND 

 Discussion 
The legend is the chart object that identifies the data series used in the chart. You can 
reposition the legend as desired within the chart area. For example, you can move the 
legend from the right side of the chart to the bottom. When you use the Format 
Legend dialog box to reposition the legend, the plot area automatically adjusts to 
accommodate the legend’s new location. 
 
In addition to repositioning the legend, you can resize it; change its border color and 
style; and format its fill color, shading, texture, and pattern. 
 
Before you can format a chart legend, you must activate Microsoft Graph. 
 

  

 
You can also reposition a legend on the Legend page in the 
Chart Options dialog box or by dragging it to a new position. 
If you drag to move or resize the legend, you must manually 
adjust the size and shape of the plot area, if necessary. 

  

 
You can also double-click a legend to open the Format Legend 
dialog box.  

  
 

  

 
When moving a legend manually, you must drag it by a 
border, not a sizing handle. 

  
 



Lesson 3 - Editing and Importing Charts PowerPoint 2002 - Lvl 2 

Page 26 Organizational & Staff Development, U of T
 

 Procedures 

1. Double-click the chart you want to edit. 

2. Click the View Datasheet button  to close the datasheet, if 
necessary. 

3. Select the legend. 

4. Click the Format Legend button . 

5. Select the Placement tab. 

6. Select the desired legend placement. 

7. Select OK. 

 

FORMATTING THE 3-D VIEW OF A CHART 

 Discussion 
You can format most Microsoft Graph chart types as either two-dimensional (2-D) or 
three-dimensional (3-D) images. You can rotate or elevate a 3-D chart to see the data 
displayed at various angles. 
 
Before you can format the 3-D view of a chart, you must activate Microsoft Graph. 

 
Formatting the 3-D view of a chart 
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You can also drag to rotate most charts. 

  

 
You cannot drag to rotate a 3-D pie chart; you must use the 
options available in the 3-D View dialog box. 

  
 

 Procedures 

1. Double-click the chart you want to edit. 

2. Click the View Datasheet button  to close the datasheet, if 
necessary. 

3. Select the Chart menu. 

4. Select the 3-D View command. 

5. Click the desired elevation icon as necessary to increase or decrease 
the chart elevation. 

6. Click the desired rotation icon as necessary to rotate the chart 
clockwise or counter-clockwise. 

7. Deselect the Auto scaling option. 

8. Select the Height box. 

9. Type the desired height. 

10. Select OK. 

 

DRAGGING TO ADJUST A 3-D CHART 

 Discussion 
Although the options available in the 3-D View dialog box provide a more precise 
way to rotate and change the elevation of 3-D charts, it is usually more convenient to 
drag to quickly adjust a 3-D chart. 
 
If necessary, you can use the Undo feature to reverse your changes. 
 

  

 
If you press the [Ctrl] key, an image of the data markers and 
chart appears as you drag. 
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 Procedures 

1. Double-click the chart you want to edit. 

2. Click the View Datasheet button  to close the datasheet, if 
necessary. 

3. Click at the intersection of any two axes. 

4. Drag any sizing handle to adjust the elevation and rotation of the 
chart. 

 

EXPLODING A PIE CHART 

 Discussion 
One of the most popular types of charts is the pie chart. The pie chart displays data as 
parts of a whole. For instance, you can use a pie chart to represent the total sales for 
an entire year; the pie chart itself can represent the year and each of the four slices can 
represent one fiscal quarter. On the pie chart, you can compare the quarters at a glance 
and immediately see which quarter represents the greatest or least sales for the year. 
 
You can explode a pie chart (pull the pieces out of it). You might want to explode an 
entire pie chart to add space for labels or only one slice to draw attention to the data 
represented by that slice. 
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An exploded pie chart 

 
  

 
By definition, a pie chart can contain only one data series. You 
can use a doughnut chart to display more than one data series 
in a pie-type chart. 

  

 
You can also drag the pie chart back together again. 

  

 
You can explode all pie slices by clicking the pie chart and 
dragging away from it. 

  
 

 Procedures 

1. Double-click the chart you want to edit. 

2. Click the View Datasheet button  to close the datasheet, if 
necessary. 

3. Select the pie chart. 

4. To explode only one pie slice, click the slice you want to explode. 

5. Drag the slice away from the pie chart. 
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SELECTING CHART OPTIONS 

 Discussion 
You can add explanatory information to a chart. The Chart Options dialog box allows 
you to insert a chart title, data labels, a legend, a chart axis, gridlines, and the data 
table. 
 
You can use the options available on the Data Labels page to insert data labels that 
display any or all of the following items: the series name, the category name, the data 
value, its percentage, and/or the bubble size, as applicable. For example, you can label 
each slice of a pie chart as a percentage of the entire pie. 

 
Adding data labels 

 
  

 
Not all options are available for all chart types in the Chart 
Options dialog box. 

  
 

 Procedures 

1. Double-click the chart you want to edit. 

2. Click the View Datasheet button  to close the datasheet, if 
necessary. 

3. Select the Chart menu. 
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4. Select the Chart Options command. 

5. Select the desired tab. 

6. Select the desired chart options. 

7. Select OK. 

 

IMPORTING AN EXCEL CHART 

 Discussion 
You can import data from other applications into a PowerPoint chart. Microsoft Graph 
allows you to import data from other spreadsheet programs, text files, and Symbolic 
Link (SYLK) files. This option is useful when you want to include information 
maintained in another program, such as Microsoft Excel. 
 
You can import an entire worksheet or chart from an Excel workbook or only a range 
of cells. New data from an Excel worksheet can be added to an existing Microsoft 
Graph datasheet. The new data can be appended to the datasheet without losing any of 
the existing data, or you can overwrite the existing Microsoft Graph datasheet. 
 
By default, the Overwrite existing cells option is selected in the Import Data Options 
dialog box. Consequently, when you import data from Excel, it replaces the existing 
data in the datasheet. For example, if you import an Excel chart that graphs sales by 
month, the monthly sales data will replace whatever data occupies the same cells in 
the PowerPoint datasheet. If the Overwrite existing cells option is deselected, 
however, the imported data will be added to the datasheet, beginning at the current 
cell. 
 

  

 
You can also select the Edit menu and then the Import File 
command to open the Import File dialog box. 

  

 
You can insert an Excel chart as an object directly into a 
PowerPoint slide by selecting the PowerPoint Insert menu 
and the Object command; then, select the Create from file 
option in the Insert Object dialog box and either type the file 
name and path or browse to find it. 

  
 

  

 
If a worksheet contains more than 255 data series or 4,000 
rows or columns, some information will not appear in the 
chart. 
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 Procedures 

1. Double-click the chart you want to edit. 

2. Click the View Datasheet button  to close the datasheet, if 
necessary. 

3. Click the Import File button  on the Microsoft Graph 
Standard toolbar.  

4. Select the Look in list. 

5. Select the drive where the file containing the chart you want to 
import is stored. 

6. Open the folder where the file containing the chart you want to 
import is stored. 

7. Select the desired file. 

8. Select Open. 

9. Select the desired worksheet from the Select sheet from workbook 
list box. 

10. Select OK. 

 



 

 

LESSON 4 -  
CREATING CUSTOM CHARTS  

In this lesson, you will learn how to: 

• Display chart axes  

• Display chart gridlines  

• Format chart gridlines  

• Format chart axes  

• Format the scale of an axis  

• Add a chart title  

• Change the data series  

• Add a drawing object to a chart  

• Add text to a chart  

• Insert a data table  
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DISPLAYING CHART AXES 

 Discussion 
Axes provide a frame of reference in a chart. A 2-D chart has two axes; the horizontal 
(x) axis usually displays the data categories (such as items, years, or quarters) and the 
vertical (y) axis usually displays the data values. The category axis can also display a 
time scale, even if the axis date has not been date-formatted. 
 
A 3-D chart displays depth as well and can have two or three axes. The category (x) 
axis and the series (y) axis form the floor of the chart and the value (z) axis rises 
vertically from the floor of the chart. When you change a 2-D chart to a 3-D chart, the 
legend items become the series (y) axis. 
 
You can display or hide chart axes. You can also format axis text, scale, value number 
format, color, and pattern. 

 
Displaying chart axes 

 
  

 
Pie and doughnut charts have no axes. 
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 Procedures 

1. Double-click the chart you want to edit. 

2. Click the View Datasheet button  to close the datasheet, if 
necessary. 

3. Select the Chart menu. 

4. Select the Chart Options command. 

5. Select the Axes tab. 

6. Under Primary axis, select the Category (X) axis option. 

7. Select the Value (Y) axis option. 

8. Select OK. 

 

DISPLAYING CHART GRIDLINES 

 Discussion 
You can add gridlines to a chart to make it easier to read. Gridlines are lines that 
extend from the tick marks on an axis across the plot area. 
 
You can choose whether or not to display gridlines. If you display gridlines, they can 
be vertical, horizontal, major, minor, or any number of other combinations. 
 
You can format gridlines by changing their color, thickness, style, and interval. 

 
Displaying chart gridlines 
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You cannot add gridlines to pie or doughnut charts. 

  
 

 Procedures 

1. Double-click the chart you want to edit. 

2. Click the View Datasheet button  to close the datasheet, if 
necessary. 

3. Select the Chart menu. 

4. Select the Chart Options command. 

5. Select the Gridlines tab. 

6. Under Category (X) axis, select the desired options. 

7. Under Value (Y) axis, select the desired options. 

8. Select OK. 

 

FORMATTING CHART GRIDLINES 

 Discussion 
You can format the gridlines in a chart. Vertical and horizontal gridlines are formatted 
independently. 
 
You can change the color, style, and weight of gridlines. For example, you can format 
major gridlines with a thick line style and minor gridlines with a thinner line style. 
 

  

 
You also can double-click any gridline to open the Format 
Gridlines dialog box. 
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 Procedures 

1. Double-click the chart you want to edit. 

2. Click the View Datasheet button  to close the datasheet, if 
necessary. 

3. Select the gridline you want to format. 

4. Click the Format Gridlines button . 

5. Select the Patterns tab. 

6. Select the Color list. 

7. Select the desired color. 

8. Select the Weight list. 

9. Select the desired weight. 

10. Select OK. 

 

FORMATTING CHART AXES 

 Discussion 
There are several ways in which you can format an axis. The Format Axis dialog box 
provides options that allow you to display and format tick marks, determine the 
location at which the value (y) axis and the category (x) axis cross, specify a font for 
the axis text, format axis numbers, and align axis text. 
 
Tick marks are the marks on an axis that indicate the data scale intervals. Displaying 
chart tick marks can make it easier to read the chart. You can change the color, 
thickness, style, and position of tick marks. 
 
Changing the font attributes of axis text can enhance the appearance of the chart. 
Additionally, the numbers in the value axis can be formatted using a variety of 
number categories, including Currency, Date, and Percentage. You can also select 
the desired number of decimal places and a currency symbol, if applicable. 
 
Category or value axis text can be rotated. This option can be used to make long labels 
less crowded-looking and easier to read. 
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Formatting chart axes 

 
  

 
You can also double-click an axis to open the Format Axis 
dialog box. 

  

 
You can hide tick marks by selecting the None option on the 
Patterns page in the Format Axis dialog box. 

  
 

 Procedures 

1. Double-click the chart you want to edit. 

2. Click the View Datasheet button  to close the datasheet, if 
necessary. 

3. Select the axis you want to modify. 

4. Click the Format Axis button . 

5. Select the Patterns tab. 

6. Select the desired options. 

7. Select additional pages and options as desired. 

8. Select OK. 
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FORMATTING THE SCALE OF AN AXIS 

 Discussion 
The axis scale determines where one axis crosses the other, as well as the location of 
tick marks and the interval between them. When you create a chart, Microsoft Graph 
creates the axis scale based on the chart data. You can use the Format Axis dialog box 
to modify axes scales. 
 
For the category (x) axis, you can specify where the value (y) axis will cross it, the 
number of categories between tick mark labels, and the number of categories between 
tick marks. You can also display the categories in reverse order. 
 
For the value (y) axis, you can designate minimum and maximum axis values, where 
you want major and minor tick marks to appear, and where you want the axes to 
intersect. You can also display the axis values as logarithms, display them in reverse 
order, or have the category axis cross at the maximum value on the value axis. 

 
Formatting the scale of an axis 

 
  

 
You also can double-click an axis to open the Format Axis 
dialog box. 
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 Procedures 

1. Double-click the chart you want to edit. 

2. Click the View Datasheet button  to close the datasheet, if 
necessary. 

3. Select the value (y) axis. 

4. Click the Format Axis button . 

5. Select the Scale tab. 

6. Select the Minimum box. 

7. Enter the minimum value you want to appear on the value (y) axis. 

8. Select the Maximum box. 

9. Enter the maximum value you want to appear on the value (y) axis. 

10. Select the Major unit box. 

11. Enter the desired distance between the major tick marks or gridlines. 

12. Select the Minor unit box. 

13. Enter the desired distance between the minor tick marks or gridlines. 

14. Select the Category (X) axis Crosses at box. 

15. Enter the value at which you want the category (x) axis to cross the 
value (y) axis. 

16. Select OK. 

 

ADDING A CHART TITLE 

 Discussion 
You can add a descriptive title to your chart, as well as category and value axes titles 
to explain the chart data. For example, you can use a category axis title to indicate the 
year to which the series labels 1st Qtr, 2nd Qtr, 3rd Qtr, and 4th Qtr refer. 
 
Chart titles are typed into text boxes. You can edit the pattern and border of a text box. 
In addition, you can format the font, size, style, color, and alignment of the text in it. 
 
You can move chart and axes title text boxes, but you cannot resize them. 
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Adding a chart title 

 

 Procedures 

1. Double-click the chart you want to edit. 

2. Click the View Datasheet button  to close the datasheet, if 
necessary. 

3. Select the Chart menu. 

4. Select the Chart Options command. 

5. Select the Titles tab. 

6. Select the desired title box. 

7. Type the title text. 

8. Select OK. 

 

CHANGING THE DATA SERIES 

 Discussion 
Data series can be represented by either the columns or the rows in the datasheet. If 
you do not know whether the data series are represented by the datasheet rows or 
columns, you can refer to the datasheet. Icons next to either the row or column 
headings indicate how the data is charted. 
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Typically, the datasheet rows are the data series and the datasheet columns are the 
data values. However, you can switch the rows and columns so that the datasheet 
columns become the data series and the datasheet rows become the data values. For 
example, if a column chart compares regional sales by quarter, it displays the quarters 
as the data series (bars) and the regions as the data values. If you switch to chart the 
data by columns instead, the regions become the data series and you can compare 
quarterly sales by region. 
 

  

 
You can also use the Series in Rows and Series in Columns 
commands on the Microsoft Graph Data menu to switch from 
rows to columns (and vice versa). 

  
 

 Procedures 

1. Double-click the chart you want to edit. 

2. Click the View Datasheet button  to close the datasheet, if 
necessary. 

3. To switch data series, click the By Column button  or the By 

Row button  on the Microsoft Graph Standard toolbar, as 
applicable. 

 

ADDING A DRAWING OBJECT TO A CHART 

 Discussion 
You can use the PowerPoint Drawing toolbar in Microsoft Graph to add drawing 
objects to a chart. For example, you can add an arrow that points to a particular data 
marker to highlight it. After you have created drawing objects, you can format, size, 
move, or delete them. 
 
The Drawing toolbar provides a variety of drawing tools for creating and editing chart 
objects and for adding color enhancements to them. You can select, fill, and rotate 
chart objects; create simple shapes (such as lines, arrows, rectangles, and ellipses); 
and add text, shadows, and 3-D effects. The Drawing toolbar also provides tools for 
selecting fill, line, and font colors, as well as line, dash, and arrow styles. In addition, 
the Insert WordArt button on the Drawing toolbar allows you to create interesting 
text effects. 
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The AutoShapes menu on the Drawing toolbar provides tools for creating a variety 
of objects, including stars and banners, action buttons, block arrows, flowcharts, and 
connectors. 

 
Adding a drawing object to a chart 

 
  

 
You can layer drawing objects on top of a chart without 
opening Microsoft Graph. The advantage of adding objects 
within the chart is that they will move and resize 
proportionally within the chart. 

  

 
You can enter text into enclosed shapes (such as circles, 
rectangles, and AutoShapes) by selecting the shape and then 
typing the desired text. 

  
 

 Procedures 

1. Double-click the chart you want to edit. 

2. Click the View Datasheet button  to close the datasheet, if 
necessary. 

3. Display the Drawing toolbar, if necessary. 

4. Click the desired drawing object on the Drawing toolbar. 
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5. Drag in the chart to draw the object. 

 

ADDING TEXT TO A CHART 

 Discussion 
You may need to add text to a chart. However, you cannot type text directly into a 
chart; you must place it in a text box. You can use text boxes to create additional 
labels or commentary. For example, you can insert a text box to add a comment about 
the level of a particular data marker. 
 
You use the Text Box button on the Drawing toolbar to add text boxes to a chart. 
You can format a text box the same way you would format any other graphic object. 
You can move and size a text box, as well as edit its pattern and border. 
 
You can format the font, size, style, color, and alignment of text within a text box. In 
addition, you can size the text in a text box to the chart. 
 
How you create a text box determines whether it expands to fit the text as you type it 
or wraps the text to fit within the text box. 

 
Adding text to a chart 
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When you click the Text Box button and then click the slide, 
you create a text box that expands to fit the text as you type; 
the text will appear on one line and will not wrap. If, however, 
you click the Text Box button and then drag to create a text 
box of fixed width, the text will wrap to a new line each time 
it reaches the right edge of the text box. 

  

 
You can manually create a new line in a text box by pressing 
the [Enter] key. 

  

 
You can layer a text box on top of a chart without opening 
Microsoft Graph. The advantage of adding a text box within 
the chart is that it will move and resize proportionally within  
the chart. 

  
 

 Procedures 

1. Double-click the chart you want to edit. 

2. Click the View Datasheet button  to close the datasheet, if 
necessary. 

3. Display the Drawing toolbar, if necessary. 

4. Click the Text Box button  on the Drawing toolbar. 

5. Drag in the chart to draw the text box. 

6. Type the desired text into the text box. 

 

INSERTING A DATA TABLE 

 Discussion 
You can display the values for each data series in a table below the chart. By inserting 
a data table, you can add explanatory detail to a chart. Data tables can enhance reports 
and provide additional information during a slide show. 
 
When you insert a data table, it usually attaches to the category axis. The data table 
rows usually represent each data series in the chart. 
 
You can display a data table in line, bar, column, and area charts. 
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You can also display the data table by selecting the Chart 
menu, the Chart Options command, and then the Show data 
table option on the Data Table page in the Chart Options 
dialog box. 

  

 
You can attach a data table to the category axis in a 3-D chart 
by selecting the Right angle axes option in the 3-D View 
dialog box. To open this dialog box, select the Chart menu 
and then the 3-D View command. 

  
 

 Procedures 

1. Double-click the chart you want to edit. 

2. Click the View Datasheet button  to close the datasheet, if 
necessary. 

3. Click the Data Table button  on the Microsoft Graph 
Standard toolbar. 

 



 

 

LESSON 5 -  
USING GRAPHIC IMAGES  

In this lesson, you will learn how to: 

• Work with graphics  

• Use the Insert Clip Art task pane  

• Use slide layouts  

• Insert a picture  

• Crop a picture  

• Move a graphic  

• Resize a graphic  

• Format a graphic  

• Recolor clip art images  

• Insert clips with Clip Organizer  

• Organize clips  
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WORKING WITH GRAPHICS 

 Discussion 
You can add graphics to a PowerPoint presentation. A graphic can enhance a 
presentation by depicting an idea that may be difficult to describe or by making the 
presentation more visually appealing. 
 
Graphic images that can be used in PowerPoint include simple drawn shapes, clip art, 
and pictures (such as scanned images that are saved as files). 
 
One method of adding graphics to a presentation is to use the Microsoft Clip 
Organizer, which contains numerous images called clip art. The Clip Organizer 
contains hundreds of professionally designed illustrations that can be freely 
incorporated into a presentation. These illustrations include people, animals, 
landscapes, banners, various types of equipment and tools, food, and an assortment of 
symbols. 
 
In addition to clip art, the Clip Organizer contains many photographs, sounds, and 
video clips that can be used to create a multimedia presentation. 
 
Another method of adding graphics to a presentation is to insert a picture from a file. 
You can purchase clip art libraries that specialize in specific types of images, such as 
for education, business, or a particular industry. 
 
Once you have inserted a graphic into a presentation, you can resize it, crop or cut 
away portions of the image, or change its colors. You also can move the graphic, 
make copies of it, and add text to it. 
 
When a clip is inserted, eight small circles called sizing handles appear in a rectangle 
around the picture. Sizing handles indicate that the picture or object is selected. The 
small, green circle is a rotate handle and can be used to rotate the clip. In addition, the 
Picture toolbar appears as soon as you select any graphic on a slide and closes when 
you deselect the graphic. 
 
When you insert clip art, the Automatic Layout Options button may appear. Inserted 
objects are often placed at a preset location on a slide. You can use the automatic 
layout options to undo or stop automatic layout, as well as to control AutoCorrect 
options. 
 
You can insert more than one clip on a slide. Once inserted, a clip can be moved or 
resized. 
 

  

 
You can delete an inserted clip or graphic by selecting it and 
pressing the [Delete] key. When you delete a graphic, 
PowerPoint may replace it with a content placeholder. 
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The first time you open the Clip Organizer, PowerPoint 
prompts you to organize all your available clip art. 

  

 
If you close the Picture toolbar while a picture is selected, it 
no longer appears automatically. To redisplay the toolbar, 
right-click any toolbar and select Picture. 

  
 

USING THE INSERT CLIP ART TASK PANE 

 Discussion 
Clip art images can add interest to a PowerPoint presentation. You can use the Insert 
Clip Art task pane to access the Clip Organizer. 
 
To find a clip, enter a word related to the type of clip art you want to insert in the 
Search text box. Words used in a search are called keywords. If you want to insert a 
clip on a slide, but you are not sure which one you want to add, you can use a 
keyword search for clips. For example, if your presentation contains the text ideas, 
you can use that keyword to search the Clip Organizer; any clip art pertaining to ideas 
will appear. 
 
You can limit searches to a specific type of collection or media file by selecting the 
corresponding option under the Other Search Options area. If you have changed 
search criteria, but have not yet performed the search, you can use the Restore button 
to return to the previous settings. 
 
After entering your search criteria and selecting the Search button, thumbnails of the 
clip art found based on the search criteria appear in the Results box. You can expand 
the Results box by clicking the button above the first image. Clicking the button again 
returns the Results box to its previous size. 
 
Pointing to a clip displays a ScreenTip with the keywords related to that image, its 
size in pixels, its file size, and its graphic format. Clicking directly on a clip inserts it 
into your presentation. You can use the list of options that appears when you right-
click a clip or click its drop-down arrow to copy or delete the clip, edit the clip 
keywords, find clips with a similar style, or view the clip properties. 
 
If the list of found clips does not suit your needs, you can use the Modify button to 
modify the search or to create a new one. 
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Inserting a clip from the task pane 

 
  

 
You can also find a graphic file by entering its file name in the 
Search text box in the Insert Clip Art task pane. In addition, 
you can use wildcard characters [such as an asterisk (*)] to 
find similarly named files. If you click the Search button with 
no text in the Search text box, the Results box displays all 
available clips. 

  

 
The Clip Organizer and Clips Online links in the Insert Clip 
Art task pane display additional ways of searching for 
graphics, sounds, and animations. 

  
 

  

 
Your search criteria is saved in the Insert Clip Art task pane 
until you manually change the selections. In order to search all 
collections for all media, you must delete the search text, reset 
all the search options, and then click the Search button. 

  
 

 Procedures 

1. Click the Insert Clip Art button  on the Drawing toolbar. 

2. If necessary, select Now in the Add Clips to Organizer message box 
to catalog the clips. 
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3. Select the Search text box. 

4. Type the desired keyword. 

5. To limit the search, click the Search in arrow. 

6. Click options as desired to select the collections you want to search 
or deselect the collections you do not want to search. 

7. Click the plus sign next to a collection to expand its contents. 

8. Click options as desired to select the collections you want to search 
or deselect the collections you do not want to search. 

9. Press [Esc]. 

10. To limit what to search, click the Results should be arrow. 

11. Click the plus sign next to any media type to expand its contents. 

12. Click options as desired to select media you want to search or 
deselect media you do not want to search. 

13. Press [Esc]. 

14. Select the Search button. 

15. Click any clip to insert it. 

16. Select Modify to change the search criteria or click the Close button 
to close the Insert Clip Art task pane. 

 

USING SLIDE LAYOUTS 

 Discussion 
PowerPoint also includes several slide layouts which contain placeholders for clip art. 
There are two types of placeholders used to insert clip art: a general content 
placeholder and a dedicated clip art placeholder. 
 
A general content placeholder provides a link to insert clip art, as well as links to 
insert tables, charts, pictures, diagrams, organization charts, and media clips. To insert 
clip art using a content placeholder, just click the Insert Clip Art icon in the 
placeholder. A dedicated clip art placeholder can only insert clip art and must be 
double-clicked. 
 
Both types of placeholders open the Select Picture dialog box, in which you can 
search for a clip art image by keyword and then insert it into the placeholder. 
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Once inserted into the placeholder, the clip appears with eight sizing handles and a 
green rotate handle, and the Picture toolbar appears. The clip can then be moved and 
resized as desired. 

 
Inserting a clip from a slide layout 

 
  

 
If a slide does not include a clip art placeholder, you can use 
the Insert Clip Art task pane to insert a clip; PowerPoint will 
place the clip in the center of the slide. 

  

 
The Import button allows you to add a new clip to the Clip 
Organizer. 

  
 

 Procedures 

1. Click the Insert Clip Art button  in the content placeholder. 

2. Type the desired keyword. 

3. Select the Search button. 

4. Select the desired clip. 

5. Select OK. 
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INSERTING A PICTURE 

 Discussion 
In addition to clip art, you can insert a picture from an existing graphic file into a 
PowerPoint presentation. Pictures can include scanned images, photographs, and 
drawn objects saved as files. 
 
PowerPoint accepts several types of graphic file formats. Some formats are accepted 
without a graphic filter. These formats include .wmf, .emf, .bmp, .rle, .dib, .gif, .jpg, 
.tif and .png. Other formats, such as .wpg and .eps, require a graphics filter, which 
can be installed using Office Setup. 
 
The Picture toolbar appears as soon as you select a picture in a slide and closes when 
you deselect the picture. 

 
Inserting a picture 

 
  

 
For more information on specific filters, type graphic filters 
in the Ask a Question box and press the [Enter] key. Then, 
select Graphics file types and filters, scroll the help topic, 
and click the desired filter.  

  

 
You can insert several pictures at once by holding the [Ctrl] 
key while selecting the files. All the selected pictures will be 
inserted into the current slide; you can then move them to the 
desired slides. 
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 Procedures 

1. Display the slide on which you want to insert the picture. 

2. Click the Insert Picture button  on the Drawing toolbar. 

3. Select the Look in list. 

4. Select the drive containing the picture file you want to insert. 

5. Open the folder containing the picture file you want to insert. 

6. Select the picture file you want to insert. 

7. Select Insert. 

 

CROPPING A PICTURE 

 Discussion 
Although cropping a picture reduces the size of the picture, cropping differs from 
sizing. When you crop a picture, you are not changing the size of the picture; you are 
actually cutting information away from it. For example, if a picture displays two 
people, you can crop it so that only one person appears in it. 
 
When you activate the Crop feature, the mouse pointer changes into a cropping tool. 
You can use the Reset Picture button on the Picture toolbar to return a picture to its 
original size. 
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Cropping a picture 

 
  

 
You can crop uniformly around the center of a picture by 
pressing the [Ctrl] key as you drag. 

  

 
Cropping can also be used to increase the background area 
around a picture. 

  
 

 Procedures 

1. Click the picture you want to crop. 

2. If necessary, display the Picture toolbar. 

2. Click the Crop button  on the Picture toolbar.  

3. Drag the desired cropping handle towards the center of the picture. 

4. Click in any blank area to deactivate the cropping tool. 
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MOVING A GRAPHIC 

 Discussion 
You can move a picture or graphic on a slide by dragging it to the desired location. 
Moving objects to place them in the best possible location is a good way to enhance 
the slide text. 
 
In order to move a graphic, the mouse pointer must be a four-headed arrow. 
 

  

 
You can also drag other slide objects, such as placeholders, 
drawn objects, charts, and tables to move them. Unfilled 
objects, such as placeholders, must be dragged by their 
borders. 

  

 
You can use the keyboard to move an object in small 
increments. Pressing any arrow key moves the selected object 
in the direction of the arrow. 

  
 

 Procedures 

1. Drag the graphic to the desired location. 

 

RESIZING A GRAPHIC 

 Discussion 
You can resize a graphic object to better fit the layout of a slide. Graphics can easily 
be resized by dragging one or more sizing handles. If you drag by any middle sizing 
handle, you change the size only in that direction. However, if you drag by any corner 
sizing handle, you change the size in two directions at once. 
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Resizing a graphic 

 
  

 
The mouse pointer must be a double-headed arrow to size a 
graphic object. 

  

 
Other slide objects (such as placeholders, drawn objects, 
charts, and tables) can also be resized by dragging. 

  

 
You can use the Reset Picture button on the Picture toolbar 
to restore a graphic to its original size. 

  
 

 Procedures 

1. Select the graphic you want to resize. 

2. Drag any sizing handle as desired to increase or decrease the size of 
the graphic. 
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FORMATTING A GRAPHIC 

 Discussion 
Although graphic files appear with certain default settings, you can use the Format 
Picture dialog box to change many of those settings. The options available in the 
Format Picture dialog box depend upon the type of graphic you are formatting. The 
Preview button in the Format Picture dialog box allows you to view your changes 
while the dialog box is still open. 
 
The options in the Colors and Lines page are used to modify the background color of 
a clip or to place a border around it. Special fill effects (such as gradients and textures) 
can be added to a background. You can place a border around any graphic; however, 
except for clip art, you cannot change the background of most graphics. After 
selecting a background color, you can use the Transparency slider to change the 
density of the color. 
 
You can use the Size page to designate a specific size for a graphic, as well as scale a 
graphic proportionally or non-proportionally. When you scale an object, you resize it 
to a percentage of its original size. 
 
Brightness and contrast options are available on the Picture page. You can change the 
color brightness and contrast to soften a clip. Additionally, clips can be changed to 
black and white, grayscale, or a washout. A washout is a graphic displayed with very 
light colors. When a washout is used in a slide background (in the slide master, for 
example), the washout appears behind the slide text. 
 
Using the Position page, you can specify an exact position for the graphic on the 
page, relative to the top left corner or center of the slide. This option is useful if you 
want to position the same graphic on several slides in the exact same location. 
 
If a graphic is to be viewed in a browser, the Web page allows you to type the text 
you want to appear while a graphic is loading, if a graphic is missing, or if the user 
has suppressed the display of graphics. 
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Formatting a graphic 

 
  

 
When you double-click an AutoShape, the Format AutoShape 
dialog box opens. 

  

 
The Picture toolbar provides buttons that duplicate many of 
the options available in the Format Picture dialog box. 

  

 
The Lock aspect ratio option on the Size page in the Format 
Picture dialog box maintains the ratio between a selected 
object’s height and width whenever you resize it. 

  
 

 Procedures 

1. Double-click the graphic you want to format. 

2. Select the Colors and Lines tab. 

3. Select the list for the option you want to modify. 

4. Select the desired option. 

5. Select the Size tab. 

6. Select or deselect options as desired. 

7. Select other options or settings as desired. 

8. Select the Picture tab. 
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9. Drag the Brightness slider to the desired percentage. 

10. Drag the Contrast slider to the desired percentage. 

11. Select additional tabs and options as desired. 

12. Move the Format Picture dialog box, if necessary, and select 
Preview to view the changes. 

13. Select OK. 

 

RECOLORING CLIP ART IMAGES 

 Discussion 
You may find a clip that fits your slide, but does not complement your color scheme. 
You can use the Recolor Picture dialog box to change the colors in clip art images. 

 
Recoloring a clip art image 

 
  

 
Clicking the Recolor Picture button on the Picture toolbar 
also opens the Recolor Picture dialog box. 

  

 
Only some graphic formats can be recolored in PowerPoint. 
To recolor a bitmap graphic, for instance, you must open 
Microsoft Paint. 
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 Procedures 

1. Double-click the graphic you want to recolor. 

2. Select Recolor. 

3. Under New, select the list for the color you want to change. 

4. Select the desired color. 

5. Select OK to close the Recolor Picture dialog box. 

6. Select OK to close the Format Picture dialog box. 

 

INSERTING CLIPS WITH CLIP ORGANIZER 

 Discussion 
In addition to using the Insert Clip Art task pane to search the Clip Organizer for 
media clips, you can open the Clip Organizer to view and insert clip art. 
 
The Clip Organizer window consists of two panes. The left pane is the Collection List, 
which displays all available collections. The right pane displays thumbnails of the 
clips stored in the selected collection. 
 
The first time you open the Clip Organizer or the Insert Clip Art task pane, 
PowerPoint scans your available drives for all media files and creates collections 
under My Collections and Shared Collections, using the same names as the folder(s) 
in which the files are stored. Collections located on web sites appear under Web 
Collections. 
 
The clip art supplied with Microsoft Office is located in the Office Collections folder. 
Office clip art is divided into several thematic collections, such as Animals, 
Concepts, People, and Seasons. Some collections contain subcollections, such as the 
Domestic and Wild folders under Animals. 
 
Browsing through the collections in the Clip Organizer is helpful if you want to view 
available clip art to get an idea for a good visual illustration. If you want to search by 
keyword, you can use the Search button on the toolbar to display the Search task 
pane in place of the Collection List. The Collection List button redisplays the 
Collection List. 
 
You can leave the Clip Organizer open while you work and use the Windows taskbar 
to switch between the presentation and Clip Organizer windows. If you copy a clip 
and then close the Clip Organizer, PowerPoint will ask if you want the clip to remain 
on the Clipboard. 
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You can use the Copy button on the Clip Organizer window 
toolbar to copy a clip. 

  

 
Right-clicking a clip or clicking its list arrow displays a 
shortcut menu. 

  

 
The Microsoft Clip Organizer comes complete with its own 
Help system, specific to inserting and using clip art. 

  
 

 Procedures 

1. Open the Insert Clip Art task pane. 

2. Select the Clip Organizer link at the bottom of the task pane. 

3. Click the plus sign next to any collection to view its contents. 

4. Continue expanding collections as desired. 

5. Select the collection you want to view. 

6. Right-click the clip you want to insert. 

7. Select the Copy command. 

8. Switch to the presentation window. 

9. Paste the clip into the desired slide. 

 

ORGANIZING CLIPS 

 Discussion 
The Clip Organizer window provides both a menu bar and a toolbar for organizing 
media clips. 
 
The default view for browsing clips is the Thumbnails view, which displays the files 
graphically. However, you can use the List or Details button on the Clip Organizer 
toolbar to view just the file names or detailed information about each file, 
respectively. 
 
The clips installed by Microsoft Office have searchable keywords already assigned to 
them. You can assign keywords to other media files as well, to make them easier to 
find. 
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In addition to the default collections PowerPoint creates in My Collections, you can 
create new collections, rename and delete collections, and move and copy clips and 
graphics to other collections. The same clip can belong to more than one collection. 
 
The Office Collections folder is read-only. Therefore, you cannot create, rename or 
delete a file in it, nor can you move or copy clips into any Office collection. However, 
clips in the Office collection can be copied to any collection under My Collections. 
 
Clips, as well as entire collections, can be deleted from My Collections. You can 
delete a clip from one or more collections or, or you can delete it from the Clip 
Organizer, which removes it from all collections. Although you cannot delete a 
collection from Office Collections, you can remove Office clips from the Clip 
Organizer. 
 
You can force PowerPoint to refresh your collections automatically, or you can use 
the Add Clips to Organizer command on the File menu to manually add clips to the 
Clip Organizer. When you add a clip to the Clip Organizer, you can select categories 
and create keywords for it. In addition, the Clips Online button allows you to 
download and add clips to your Clip Organizer from the Microsoft Clip Gallery web 
site. 
 
The Clip Organizer can be collapsed to view a slide. 

 
Adding a keyword to a clip 

 
  

 
If you select multiple clips, you can use the All Clips at Once 
page in the Keywords dialog box to add the same keyword to 
all the selected clips. To select multiple clips, hold the [Ctrl] 
key and click each desired clip; to select all clips in the 
collection, select the Edit menu and the Select All command. 
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You can delete a clip from a collection by right-clicking it and 
selecting the Delete from “collection” command. You can 
delete a collection by right-clicking it in the Collection List 
pane and selecting the Delete “collection_name” command. 

  

 
Collections are not physical folders on a drive. When you 
move or copy a clip to another collection, you are not actually 
moving or copying the file, you are just creating or modifying 
the shortcut to the actual file. 

  
 

 Procedures 

1. Open the Insert Clip Art task pane, if necessary. 

2. Select the Clip Organizer link at the bottom of the Insert Clip Art 
task pane and update the clips in the Clip Organizer, if necessary. 

3. Click the plus sign next to any collection to view its contents. 

4. Expand collections as necessary, and select the desired collection. 

5. Select the desired view. 

6. Continue selecting views as desired. 

7. Right-click the clip for which you want to edit keywords. 

8. Select the Edit Keywords command. 

9. Select the Keyword box. 

10. Enter the desired keyword. 

11. Select Add. 

12. Select Apply. 

13. To view the next clip, select Next. 

14. When you have finished adding keywords, select OK. 

15. To create a new collection, right-click the desired location for the 
collection in the Collection List. 

16. Select New Collection. 

17. Enter the desired name for the new collection. 

18. Select OK. 

19. To copy a clip to a different collection, drag it to the desired 
collection. 



PowerPoint 2002 - Lvl 1 Lesson 5 - Using Graphic Images 

Organizational & Staff Development, U of T Page 65
 

20. To move a clip to another collection, hold [Alt] and drag it to the 
desired collection. 

 



 

 

LESSON 6 -  
WORKING WITH DRAWING OBJECTS  

In this lesson, you will learn how to: 

• Use the Drawing toolbar  

• Draw an enclosed object  

• Display the drawing guides and grid  

• Change the fill color of an object  

• Apply a fill effect  

• Apply 3-D and shadow styles  

• Draw a line  

• Format lines  

• Create a text box  

• Draw an AutoShape  

• Rotate an object  

• Flip an object  

• Order stacked objects  

• Align objects  

• Group objects  



PowerPoint 2002 - Lvl 1 Lesson 6 - Working with Drawing Objects 

Organizational & Staff Development, U of T Page 67
 

USING THE DRAWING TOOLBAR 

 Discussion 
The Drawing toolbar, which appears by default when you launch PowerPoint, 
provides several tools and features to assist you in drawing and editing slide objects 
and text. For example, if you want to add a balloon graphic to a slide, you can use the 
Oval and Line buttons on the Drawing toolbar to draw the balloon and its string. 
 
The Drawing toolbar provides a variety of drawing tools that can be used to create 
and edit objects, as well as add color enhancements to them. These tools allow you to 
create simple shapes such as lines, arrows, rectangles, and ellipses and to add text 
boxes, shadows, and 3-D settings. The Drawing toolbar also contains tools for 
selecting fill, line, and font colors and line, dash, and arrow styles. 
 
The AutoShapes menu on the Drawing toolbar contains tools for creating a variety of 
object shapes, including stars and banners, action buttons, block arrows, and 
connectors for flowcharts. 
 
The Draw menu provides options for aligning, distributing, rotating, and flipping 
objects, as well as for changing the order of overlapping layers. You can also group 
multiple objects together so that they can be moved or resized as one object. If the 
selected object is a curve or freeform shape, you can use the Edit Points command to 
change its shape. In addition, you can use the Draw menu to reroute connectors on 
flowcharts and diagrams. This menu also allows you to move an object in small 
increments (nudge an object) and change a selected object from one AutoShape to 
another. 
 
To assist you in precision drawing, you can display the drawing rulers, drawing 
guides, and gridlines. These tools do not automatically appear in the slide window; 
you must display them in order to use them. 

 
The Drawing toolbar 

 
  

 
If the Drawing toolbar does not appear in the presentation 
window, you can display it. You can also drag the toolbar as 
needed to reposition it in or around the slide area. 

  

 
If drawing objects are added to the slide master, they appear 
on every slide in a presentation, except the title slide. 

  
 



Lesson 6 - Working with Drawing Objects PowerPoint 2002 - Lvl 1 

Page 68 Organizational & Staff Development, U of T
 

DRAWING AN ENCLOSED OBJECT 

 Discussion 
You can draw objects directly on a slide using the drawing tools on the Drawing 
toolbar. Using these tools, you can draw enclosed objects and then move, copy, and/or 
resize them as desired. Enclosed drawing objects, such as rectangles or ovals, are 
filled by default. Filled objects are opaque and contain patterns and/or colors. If filled 
objects are drawn in front of other slide objects, the objects behind them are hidden. 
You can, however, remove an object’s fill in order to view the objects behind it. 
 
When you are drawing an object, the mouse pointer changes into a crosshair. The 
center of the crosshair represents the outer border of the object. An object is 
automatically selected when you finish drawing it. A selected object displays eight 
sizing handles and a green rotate handle, which can be used to rotate the object to the 
desired position. 

 
Enclosed drawn objects 

 
  

 
To draw a square using the Rectangle button or a circle using 
the Oval button, hold the [Shift] key as you drag. 

  

 
You can type text into an enclosed object. After entering text 
into the object, you can use the Text Box page in the Format 
AutoShape dialog box to wrap the text within the object’s 
borders. 
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To draw more than one object of the same type, double-click 
the desired drawing object button. After you have drawn the 
desired number of objects, you can press the [Esc] key or click 
the drawing object button again to return to normal editing 
mode. 

  
 

 Procedures 

1. Click the desired drawing object button on the Drawing toolbar. 

2. Drag to position and size the object as desired. 

 

DISPLAYING THE DRAWING GUIDES AND GRID 

 Discussion 
PowerPoint provides several tools that can be used to align and size objects on a slide. 
In addition to displaying the horizontal and vertical rulers, you can also display 
drawing guides and the grid. 
 
The drawing guides appear as a single set of dashed horizontal and vertical lines that 
intersect on the slide. Both the horizontal and vertical guides are moveable and 
display their exact position in a ScreenTip when moved. You can use the guides to 
position an object on a vertical or horizontal straightedge. When you drag an object 
close to a guide, its center or edge automatically aligns to the guide. 
 
The grid is a series of intersecting, evenly-spaced dotted lines. You can set the spacing 
between the dots that make up the grid lines. Spacing can be as small as 1/24 inch and 
as large as 2 inches. By default, objects you create or position automatically align to 
the nearest horizontal and vertical dot, even when the grid lines are not displayed. 
This is called the snap-to feature. If you select a spacing of 1/4 inch, objects will snap 
to positions that are 1/4 inch apart. With 1/4 inch (.25) snap enabled, you would not be 
able to position an object at .35 inches. 
 
In addition to snapping to the grid, you can snap objects to other objects. With this 
option enabled, you can easily align objects. 
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Displaying the drawing guides and grid 

 
  

 
To freely position an object, you can disable all snap-to 
options. You can also temporarily disable snap-to by holding 
the [Alt] key as you drag an object. 

  

 
You can also use the Show/Hide Grid button on the 
Standard toolbar to display or hide the grid. 

  
 

 Procedures 

1. Select the View menu. 

2. Select the Grid and Guides command. 

3. Under Snap to, select or deselect the desired option. 

4. Under Grid settings, select the Display grid on screen option. 

5. Select the Spacing list. 

6. Select the desired spacing option. 

7. Select the Display drawing guides on screen option. 

8. Select OK. 

9. Drag the guides to the desired position. 
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CHANGING THE FILL COLOR OF AN OBJECT 

 Discussion 
When you draw an object on a slide, PowerPoint automatically applies a default fill 
color to it. You can change the fill color of an object or remove its fill color so that the 
object is transparent. For example, if you draw a circle on a slide, it appears with the 
default fill color supplied by PowerPoint. If you want the circle to represent the sun, 
you can change the fill color to yellow. 
 
You can select a color from the Fill Color palette or you can select the More Fill 
Colors command to view additional color options. The Automatic command on the 
Fill Color palette returns the fill of an object to its default fill color. 
 
You must select the object(s) to which you want to add a fill color before you can 
apply the fill color. 
 

  

 
You can also double-click an object and select the Colors and 
Lines tab to change the fill color. 

  
 

  

 
You must click the arrow on the Fill Color button to display 
the color palette. If you click the button, PowerPoint changes 
the fill of the selected object to the color displayed on the Fill 
Color button. 

  
 

 Procedures 

1. Select the object with the fill color you want to change. 

2. Click the arrow on the Fill Color button  on the Drawing 
toolbar. 

3. Select the desired fill color. 
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APPLYING A FILL EFFECT 

 Discussion 
Special fill effects can be added to the background of an object using the Fill Effects 
dialog box. Fill effects include gradients, textures, patterns, and pictures. 
 
A gradient is a color effect in which the shading gradually changes. Options on the 
Gradient page include using one, two, or preset colors for the gradient. If you elect to 
use only one color, you can use the Dark/Light slider to adjust whether the color 
fades to black or to white. The Transparency sliders adjust the density at the starting 
and ending points of the gradient colors. Under Shading styles and Variants, you can 
select a direction for the shading and one of four variants for that direction, 
respectively. 
 
You can also choose from a number of preset gradients, such as Early Sunset, 
Horizon, and Desert. You can change the transparency and direction of a preset 
gradient, but not its colors. 
 
You can select a textured background from the Texture page. Colors and textures are 
preset and cannot be modified. You can use the Other Textures button to search for 
other background files. 
 
The Pattern page contains a number of preset patterns from which you can choose. 
You can select separate foreground and background colors for each pattern. The 
pattern appears in the selected foreground color against the selected background color. 
 
The Picture page allows you to select a graphic file or another clip art picture as the 
background for a graphic object. You can use the Select Picture button to search for 
pictures. 
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The Fill Effects dialog box 

 

 Procedures 

1. Select the object to which you want to apply a fill effect. 

2. Click the arrow on the Fill Color button  on the Drawing 
toolbar. 

3. Select Fill Effects. 

4. To apply a gradient, select the Gradient tab and the desired options 
under Colors, Transparency, Shading styles, and Variants. 

5. To apply a pattern, select the Pattern tab, the desired option under 
Pattern, and the Foreground and Background colors. 

6. To apply a texture, select the Texture tab and select the desired 
texture. 

7. To apply a picture, select the Picture tab and use the Select Picture 
button to browse for the desired picture. 

8. Select OK. 
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APPLYING 3-D AND SHADOW STYLES 

 Discussion 
Shadows and 3-D styles applied to objects can create interest or a feeling of depth. 
 
A 3-D effect makes an object appear three-dimensional. You can select from a variety 
of 3-D effects. Once you have added a 3-D effect to an object, you can use the 3-D 
Settings toolbar to apply various Depth, Direction, Lighting, Surface, and Color 
settings. You can also tilt a 3-D object up, down, left, or right. Depending on the 
object selected, certain options may not be available. 
 
A shadow is a dark border around one or more sides of an object. A shadow makes an 
object appear raised from the background. You can select from a variety of shadows. 
Once you have added a shadow effect to an object, you can use the Shadow Settings 
toolbar to modify the shadow effect. From this toolbar, you can move the shadow up, 
down, right, or left, as well as change the color of the shadow. 
 
You can also apply a shadow effect to text. Shadow settings affect all the text in a 
placeholder; consequently, you cannot change the shadow setting for specific words 
within the placeholder. 

 
Applying shadow settings 

 
  

 
An object can have either a shadow or a 3-D effect, but not 
both. 
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You cannot assign a line color to a filled, 3-D object, but you 
can change the fill color. 

  
 

  

 
Shadow effects applied to text may not appear until you click 
outside of the placeholder. 

  
 

 Procedures 

1. Select the object to which you want to add a 3-D effect. 

2. Click the 3-D Style button  on the Drawing toolbar. 

3. Select the desired 3-D style. 

4. To change the 3-D settings, click the 3-D Style button . 

5. Select 3-D Settings. 

6. Select the desired 3-D settings. 

7. Select the object to which you want to add a shadow. 

8. Click the Shadow Style button  on the Drawing toolbar. 

9. Select the desired shadow style. 

10. To change the shadow settings, click the Shadow Style button . 

11. Select Shadow Settings. 

12. Select the desired shadow settings. 

 

DRAWING A LINE 

 Discussion 
Lines can be used to indicate separate sections of a slide or to add visual effects. For 
example, you can add lines to separate bullet items in a slide. Lines can be drawn at 
various angles and positions. Drawn lines can be moved and sized as desired. 
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When you draw a line, the mouse pointer changes into a crosshair. The center of the 
crosshair is the point at which the line is drawn. 
 

  

 
To create a straight line, hold the [Shift] key as you drag. If 
you move the mouse pointer up or down, the angle of the line 
changes in 15-degree increments. 

  
 

 Procedures 

1. Click the Line button  on the Drawing toolbar. 

2. Drag to draw the line as desired. 

 

FORMATTING LINES 

 Discussion 
You can format lines by changing the line style, color, and dash style. In an enclosed 
object, the line is the border around the object. In an open object, such as a line or an 
arrow, the line is the object itself. 
 
You can change the style of an existing line. Line styles pertain to the thickness of a 
line, as well as to double- and triple-line styles. For example, to more dramatically 
separate items in a slide, you can increase the width of the line that separates them. In 
addition, you can change the style of an existing line to a dash style. Dash styles break 
the line into dots or dashes. 
 
You can also change the line color of a drawing object. Changing the line color can 
enhance the appearance of the object. For example, if you are creating a logo, 
changing the line color can help distinguish the border of the logo. 
 
The Line Color button has two components. The Line Color button itself always 
displays the currently selected color. To apply this line color to a selected object, you 
only have to click the Line Color button. You can also use the Line Color list to 
select a different color from the color palette. 
 

  

 
You can use the Arrow Style button on the Drawing toolbar 
to apply an arrowhead to a line. You can also draw arrows 
using the Arrow button on the Drawing toolbar. 
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 Procedures 

1. Select the line you want to format. 

2. To change the line style, click the Line Style button  on the 
Drawing toolbar. 

3. Select the desired line style. 

4. To change the line color, click the arrow on the Line Color button 

 on the Drawing toolbar. 

5. Select the desired line color. 

6. To change the dash style, click the Dash Style button  on the 
Drawing toolbar. 

7. Select the desired dash style. 

 

CREATING A TEXT BOX 

 Discussion 
Although most slide layouts include placeholders for text boxes, you can create text 
boxes as desired to label objects or graphics, add captions, or create additional notes. 
Text created using the Text Box button on the Drawing toolbar is not part of the 
presentation slide outline; the outline includes only the text created in layout text 
placeholders. Text boxes can be added to the slide master to display the same text on 
every slide (such as a company name). 
 
You can either click at the desired slide location to create a text box, or you can drag 
to draw it. When you click to create a text box, the text box automatically expands as 
needed to accommodate the text. When you drag to create a text box, however, the 
text box has a fixed width, the text wraps to a new line when it reaches the right edge 
of the text box, and the text box automatically expands in length to fit the text. Using 
either method, you can resize the text box to fit the text, or you can wrap the text to fit 
the text box. 
 
You can edit text in a text box the same way you edit any other presentation text. 
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Adding text to a text box 

 
  

 
You can manually create a new line in a text box by pressing 
the [Enter] key. 

  

 
Double-clicking a text box opens the Format Text Box dialog 
box. The Size page contains options that allow you to define 
the precise size and position of the selected text box. The Text 
Box page contains options for wrapping the text and 
automatically resizing the text box to fit the text. 

  
 

 Procedures 

1. Click the Text Box button  on the Drawing toolbar. 

2. Click in the slide or drag to draw the text box, as desired. 

3. Type the desired text. 
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DRAWING AN AUTOSHAPE 

 Discussion 
You can create objects quickly and easily using the commands on the AutoShapes 
menu on the Drawing toolbar. The AutoShapes menu provides a variety of categories 
for creating different shapes. The AutoShapes categories include Lines, Connectors, 
Basic Shapes, Block Arrows, Flowchart, Stars and Banners, Callouts, and Action 
Buttons. The More AutoShapes option opens the Insert Clip Art task pane, which 
contains a selection of additional clip art images. 
 
You can easily add text to an AutoShape by selecting the AutoShape and typing the 
text. Once the text has been entered, you can format or wrap it to fit the AutoShape. 

 
A block arrow AutoShape 

 
  

 
To maintain an AutoShape’s width-to-height ratio, hold the 
[Shift] key as you drag. 

  

 
You can wrap existing text to fit an AutoShape by double-
clicking the shape to open the Format AutoShape dialog box. 
Select the Text Box page and enable the Word wrap text in 
AutoShape option. 

  

 
To insert an AutoShape with a predefined size, select the 
AutoShape and click in the slide. You can also use the Format 
AutoShape dialog box to define a precise size and position for 
an existing AutoShape. 



Lesson 6 - Working with Drawing Objects PowerPoint 2002 - Lvl 1 

Page 80 Organizational & Staff Development, U of T
 

  
 

 Procedures 

1. Select the AutoShapes menu on the Drawing toolbar. 

2. Point to the desired command. 

3. Click the object you want to draw. 

4. Drag to draw the object on the slide. 

5. To insert text, type the desired text. 

 

ROTATING AN OBJECT 

 Discussion 
When you select a graphic object, a green rotate handle appears at the top of the 
object. The rotate handle allows you to freely rotate the object by turning it in any 
direction. 
 
If the object you are rotating contains text, the text rotates with the object. 

 
A rotated object 
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You can also enable free rotation by selecting the Draw menu 
on the Drawing toolbar, pointing to the Rotate or Flip 
command, and selecting the Free Rotate command. This 
option displays multiple rotate handles on an object. 

  

 
You can reset the rotation of an object by double-clicking the 
object, selecting the Size page, and changing the degrees in 
the Rotation box to 0. 

  
 

 Procedures 

1. Select the object you want to rotate. 

2. Drag the green rotate handle in the desired direction. 

 

FLIPPING AN OBJECT 

 Discussion 
In addition to freely rotating an object, you can flip an object horizontally or 
vertically. Flipping an object creates a mirror image of the object. Flipping is useful if 
you have an object such as a pointing hand facing the wrong direction or if the object 
contains text that will display upside down if rotated. 

 
Flipping an object 
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 Procedures 

1. Select the object you want to flip. 

2. Select the Draw menu on the Drawing toolbar. 

3. Point to the Rotate or Flip command. 

4. Select the Flip Horizontal or Flip Vertical command, as desired. 

 

ORDERING STACKED OBJECTS 

 Discussion 
Stacking refers to the placement of objects, front to back. PowerPoint automatically 
stacks objects as you draw them and places each object on a unique graphic layer. 
You can stack an unlimited number of objects in PowerPoint. 
 
PowerPoint stacks objects in the order in which they were created. As a result, the first 
object drawn is at the back of the stack and the last object drawn is at the front. For 
example, if you draw an oval to represent an eye and then draw a circle to represent 
the eye's pupil in the same location on the slide, the pupil appears in front of the eye. 
 
You can change the order of stacked objects so that a selected object moves in front of 
or behind other objects. 
 
The Order submenu on the Draw menu includes four commands for changing the 
order of stacked objects. The Bring to Front and Send to Back commands move a 
selected object to the front or back of the entire stack. The Bring Forward and Send 
Backward commands move a selected object forward or backward, one layer at a 
time. 
 

  

 
At times, an object may be completely hidden in the stack. 
You can locate the desired object by pressing the [Tab] key or 
the [Shift+Tab] key combination to move through the objects 
in the stack one at a time. 
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 Procedures 

1. Select the object you want to order. 

2. Select the Draw menu on the Drawing toolbar. 

3. Point to the Order command. 

4. Select the desired command. 

 

ALIGNING OBJECTS 

 Discussion 
You can align objects to create rows or columns of objects or to make a slide appear 
symmetrical. For example, if you draw squares to represent windows on a house, you 
can align the windows so that they appear symmetrical and level on the house. 
 
You can align objects either vertically or horizontally, as well as by their edges or 
their centers. 
 
You can also align single or multiple objects relative to the slide. To align objects to 
the slide, you must first select the Relative to Slide command from the Align or 
Distribute submenu on the Draw menu and then the desired alignment. 

 
Aligning objects 
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If you drag to select objects you want to align, make sure that 
the marquee completely includes all the desired objects.  

  

 
The Align or Distribute submenu on the Draw menu contains 
the Distribute Horizontally and Distribute Vertically 
commands. You can use these commands to arrange objects 
equal distances from one another. 

  
 

 Procedures 

1. Select the first object you want to align. 

2. Hold [Shift] and select any additional objects you want to align. 

3. Select the Draw menu on the Drawing toolbar. 

4. Point to the Align or Distribute command. 

5. Select the desired command. 

 

GROUPING OBJECTS 

 Discussion 
When objects are grouped, you can work with them as if they were a single item. 
 
Grouping is particularly useful when multiple objects are intended to work together. 
When you combine multiple objects into a single group, you can size and position the 
grouped objects as a single object. In other words, you can copy, flip, rotate, and size 
the grouped objects as a unit, rather than duplicating, moving, or changing each item 
individually. 
 
Although an item may be grouped, you can still select an individual object in the 
group and modify it separately. However, if you want to change the size or position of 
a object in a group, you must ungroup it. After you have made the desired changes, 
you can regroup the objects to preserve the object as a single unit. 
 
Imported graphics (such as pictures and clip art) often consist of multiple objects that 
have already been grouped into a single object. You can create interesting effects by 
ungrouping them and making changes to the individual objects. You can change 
object attributes or rearrange, resize, and delete objects from the graphic. You can 
even combine elements from different images. You can then regroup the objects to 
form new, modified images. 
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A grouped object 

 
  

 
If you want to ungroup an object to make individual changes 
to it, select the object you want to ungroup, select the Draw 
menu on the Drawing toolbar, and then select the Ungroup 
command. 

  

 
If you ungroup a clip art picture, PowerPoint prompts you to 
convert it into a Microsoft Office drawing object. 

  

 
You can select multiple objects by holding the [Shift] key and 
clicking each object you want to select. You can also select 
multiple objects by clicking the Select Object button on the 
Drawing toolbar and dragging a marquee around all the 
objects you want to group. 

  
 

 Procedures 

1. Select all the objects you want to group. 

2. Select the Draw menu on the Drawing toolbar. 

3. Select the Group command. 

 



 

 

LESSON 7 -  
USING ORGANIZATION CHARTS/DIAGRAMS  

In this lesson, you will learn how to: 

• Create an organization chart  

• Add text to shapes  

• Add positions to shapes  

• Select multiple shapes  

• Rearrange shapes  

• Format shapes  

• Insert a diagram  

• Work with diagrams  
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CREATING AN ORGANIZATION CHART 

 Discussion 
An organization chart displays the hierarchical relationships within a business, 
society, or other group. An organization chart consists of shapes and connecting lines. 
Each shape contains the name and position of one person. The lines (connectors) 
between shapes represent relationships between people in the organization. Generally, 
the shapes closer to the top of the chart represent a higher position in the organization. 
For example, the company president or CEO normally appears at the top of an 
organization chart, and any vice-presidents or departmental managers appear in shapes 
at lower levels. 
 
To create an organization chart in PowerPoint, you can apply an organization chart 
slide layout to a new or an existing slide. You can also add the organization chart 
layout to a slide by clicking the Insert Diagram or Organization Chart button on 
the Drawing toolbar or by selecting the Diagram command on the Insert menu. In 
addition, you can insert an organization chart into a new or an existing slide as a 
picture. 
 
When you insert an organization chart, it appears in a drawing canvas. The drawing 
canvas can be resized and moved as desired. 
 
PowerPoint treats an organization chart as an object. You can add animation effects to 
objects, as well as use the tools on the Drawing and Organization Chart toolbars to 
format and recolor the object. You can change the formatting of the entire chart by 
selecting a preset format from the Organization Chart Style Gallery. Or, if you prefer, 
you can format individual shapes and lines using buttons on the Drawing toolbar. 
 
You can also use Microsoft Organization Chart, an OLE (Object Embedding and 
Linking) application to create organization charts. Microsoft Organization Chart is 
available from the Insert Object dialog box. If you use the Insert Object dialog box to 
insert an organization chart, you can display the organization chart as an icon on the 
slide. This option links the slide to the organization chart and the organization chart 
itself does not appear on the slide. 
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Inserting an organization chart 

 
  

 
The default shape on an organization chart is a rounded 
rectangle. You can change the default shape using the 
Autoformat button on the Organization Chart toolbar. 

  

 
You can also create an organization chart from any slide 
layout containing the Diagram or Organization Chart 
placeholder. 

  
 

 Procedures 

1. Display the slide on which you want to create an organization chart 
and the Drawing toolbar. 

2. Click the Insert Diagram or Organization Chart button  on 
the Drawing toolbar. 

3. Select the Organization Chart icon. 

4. Select OK. 
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ADDING TEXT TO SHAPES 

 Discussion 
The default organization chart contains four shapes. By default, the top shape is the 
manager position. The three shapes below the manager position are the subordinate 
positions. For example, you can type the name and position of the company president 
into the manager shape at the top, and then type the names and positions of the vice 
presidents into the shapes below it. 
 
You can edit shapes, format text, or add and delete shapes. For example, you can type 
a name and the title President in the top shape and format the text as desired. The 
shapes in an organization chart adjust automatically to accommodate the text within 
them and, when you deselect a shape after entering text, the drawing canvas 
automatically adjusts to fit the shapes within it. 
 
You do not need to select the organization chart before making changes. When you 
select any shape in the organization chart, the chart is automatically selected. 

 
Adding text to a shape 

 

 Procedures 

1. Select the shape to which you want to add text. 

2. Enter the desired name. 
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3. Press [Enter] to move to the next line. 

4. Enter the desired title. 

 

ADDING POSITIONS TO SHAPES 

 Discussion 
You can add shapes to an organization chart as needed. For example, if you want to 
add a department head who reports to a vice president, you could add a subordinate 
shape to the vice president shape. 
 
You can create the following types of shapes: 

 
Type Position 

Subordinate Appears below and is connected to the selected shape 

Coworker Appears adjacent to and is connected to the selected 
shape 

Assistant Branches off from a connecting line, below the 
selected shape 

 
You can manually draw additional connecting lines in an organization chart. For 
example, you may want to show a secondary reporting relationship between two 
positions. If you select a connector from the AutoShapes menu on the Drawing 
toolbar, the connecting line will move or adjust as needed if you reposition either 
shape. You can then use the drawing tools on the Drawing toolbar to format 
connecting lines. 
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Adding a subordinate shape 

 
  

 
To delete a shape from an organization chart, select the shape 
and press the [Delete] key. 

  
 

  

 
You can also use the Line tool on the Drawing toolbar to 
draw lines between shapes; however, if you draw a line rather 
than a connector between shapes, it will not adjust for changes 
made to the shapes. 

  
 

 Procedures 

1. Select the shape to which you want to add a position. 

2. Select the Insert Shape button on the Organization Chart toolbar. 

3. Select the desired shape. 
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SELECTING MULTIPLE SHAPES 

 Discussion 
You can select multiple shapes in order to format or move all of them at once. 
 
You can use any of the following methods to select multiple shapes: 

 
To Select Method 

Multiple shapes Hold the [Shift] or [Ctrl] key as you click 
each shape you want to select. 

Multiple adjacent 
shapes 

Drag a marquee that completely includes 
each shape you want to select. 

All shapes on the same 
level 

Select any shape on the desired level; then, 
select the Select button on the Organization 
Chart toolbar and the Level command. 

All shapes in a branch Select the desired shape; then, select the 
Select button on the Organization Chart 
toolbar and the Branch command. 

All shapes in the 
organization chart 

Select the manager shape; then, select the 
Select button on the Organization Chart 
toolbar and the Branch command. 

 
 

  

 
In order to move individually selected shapes, the 
AutoLayout command on the Layout menu of the 
Organization Chart toolbar must be deselected. 

  

 
To select all connecting lines in a chart, select the Select 
button on the Organization Chart toolbar and the All 
Connecting Lines command. 

  
 

REARRANGING SHAPES 

 Discussion 
You can change the arrangement of the shapes in an organization chart. For example, 
you can arrange the shapes so that they align vertically. In this arrangement, the 
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subordinate shapes appear one below the other. When you select the Layout button on 
the Organization Chart toolbar, a menu of available layouts appears. 
 
To change the layout, you must select the highest level in the branch you want to 
format. A warning box will open if the correct shape is not selected. 
 
You can arrange the shapes in an organization chart into one of four available formats: 
Standard, Both Hanging, Left Hanging, or Right Hanging. In addition, other 
layout options include fitting the organization chart to its contents, enlarging the 
canvas to add more white space around the chart, and scaling the chart to resize it. 
 
With AutoLayout enabled, you can drag nearly any shape, with the exception of 
manager shapes, to new positions to modify the reporting relationships. Disabling 
AutoLayout allows you to resize a specific shape or drag it to a new location in the 
organization chart. AutoLayout is automatically enabled when you create a new 
organization chart. 

 
Changing the chart layout 

 
  

 
When dragging a shape to a new position, you must place the 
shape over the destination shape and then release the mouse 
button. 

  

 
If you re-enable AutoLayout after making changes to the size 
and location of shapes, any shapes you have moved or resized 
may resume their original size and position. 
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Choosing the Fit Organization Chart to Contents command 
from the Layout menu automatically reduces the font size of 
all text in the organization chart shapes as needed. 

  
 

 Procedures 

1. Select the shape of the highest level in the branch you want to 
rearrange. 

2. Select the Layout button on the Organization Chart toolbar. 

3. Select the desired layout option. 

 

FORMATTING SHAPES 

 Discussion 
You can format the shapes, connecting lines, and background of an organization chart 
to enhance its appearance. For example, you can apply the same formatting to all 
assistant level shapes and their connecting lines at the same time. You can customize 
the background of a chart to match or contrast with the slide color scheme. 
 
If an organization chart is formatted with the Default Autoformat style, you can use 
the tools on the Drawing toolbar to manually format individual shapes or connecting 
lines. You can change the color, border style, and thickness of a shape, as well as add 
a shadow to it. Connecting lines can be formatted with different colors, line styles, and 
line thickness. The default style also allows you to choose a different AutoShape for 
any shape in the chart. 
 
You can use Autoformat to apply a preset design scheme to a chart. When you apply a 
preset design scheme, the formatting is applied to all the shapes and connecting lines 
in the chart. The Organization Chart Style Gallery offers many different formats from 
which to choose, including brackets, boxes, and braces. 
 
Whether you choose a preset design or format shapes and connecting lines manually, 
you can add a background color or fill, as well as a border around the chart, using 
buttons on the Drawing toolbar. A fill or pattern effect can also be applied to the 
background of a chart. 
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Formatting a shape 

 
  

 
AutoLayout does not need to be enabled in order to apply a 
preset design format from the Organization Chart Style 
Gallery. 

  
 

 Procedures 

1. Display the Drawing toolbar. 

2. Select the organization chart you want to format. 

3. Select the shape you want to format. 

4. Using the Drawing toolbar, format the shape as desired. 

5. Select the connecting line you want to format. 

6. Using the Drawing toolbar, format the connecting line as desired. 

7. To format the organization chart background, select any blank area 
of the chart. 

8. Format the background as desired. 

9. To apply a preset design scheme, click the Autoformat button  
on the Organization Chart toolbar. 

10. Select the desired chart style. 
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11. Select Apply. 

 

INSERTING A DIAGRAM 

 Discussion 
Related information can often be presented more effectively in a diagram than in a 
table or discussion. 
 
PowerPoint provides five predefined diagrams from which you can choose: Venn, 
Cycle, Pyramid, Target, and Radial. An organization chart is also available from the 
Diagram Gallery dialog box. 
 
When you insert a new diagram, the diagram is placed on a drawing canvas. The 
canvas can be resized to fit the diagram. 

 
Inserting a Venn diagram 

 
  

 
If you have already created a diagram and want to change its 
type, you can select the Change to list on the Diagram 
toolbar and select another diagram type. 

  

 
You can resize the drawing canvas by dragging one of the 
black sizing handles. 
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 Procedures 

1. Select the slide on which you want to insert the diagram. 

2. Click the Insert Diagram or Organizational Chart button  on 
the Drawing toolbar. 

3. Select the desired diagram type. 

4. Select OK. 

 

WORKING WITH DIAGRAMS 

 Discussion 
You can customize a diagram to meet your needs. Additional shapes can be inserted 
and moved from front to back, labels can be added, and shapes within the diagram can 
be changed to different colors and/or styles to emphasize distinct concepts. 
 
PowerPoint provides an AutoFormat feature that allows you to pick from predefined 
styles. You can, however, disable this feature and work on your own. 
 
Diagram layout options include tightly fitting the drawing canvas to the diagram, 
expanding the drawing canvas to add more white space around the diagram, and 
scaling the diagram to resize it. To freely move diagram elements, you must disable 
the AutoLayout feature. If you then enable the AutoLayout feature, however, any 
shapes you have moved or resized will resume their original size and position. 
 
Even after your diagram has been created, you can change to another diagram type by 
selecting the Change to button on the Diagram toolbar. When changing diagram 
types, PowerPoint enables both the AutoLayout and AutoFormat features. 
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Modifying a diagram 

 
  

 
The Cycle, Venn, and Target diagrams provide text boxes for 
each shape. The text boxes can be resized if the AutoLayout 
feature is disabled. 

  

 
You can also resize a diagram by double-clicking in a blank 
area of the drawing canvas and using the Size page in the 
Format Diagram dialog box to size or scale the diagram. 

  

 
You can change the format of the shape to which an 
AutoFormat style has been applied by right-clicking the shape 
and deselecting the Use AutoFormat command. 

  
 

 Procedures 

1. Select the diagram you want to modify. 

2. To add a label, click in the applicable text box. 

3. Type the desired label text. 

4. Select the Insert Shape button on the Diagram toolbar to add a new 
diagram shape. 

5. Click the Move Shape Forward or Move Shape Backward button 
on the Diagram toolbar to move the shape to the desired location in 
the diagram. 
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6. Click the AutoFormat button  on the Diagram toolbar. 

7. Select the desired style. 

8. Select Apply. 

9. Select the Layout button on the Diagram toolbar. 

10. Select the desired layout option. 

11. Modify the diagram layout as desired. 
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repositioning the legend, 25, 26 
selecting options, 30 
using in presentations, 16 

Clip Organizer, 48, 49, 61, 62 
collections, 63 

Clips 
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inserting into charts, 45, 46 

Datasheet, 17 
deleting data from, 18 
entering data into, 19 

Diagrams 
customizing, 97, 98 
inserting, 96, 97 

Drawing guides 
displaying, 69, 70 

Drawing objects 
adding to charts, 42, 43 

Drawing toolbar, 67 
Edit points, 67 
Excel charts 

importing, 31, 32 
Fill color, 71 
Fill effects 

applying, 72, 73 
Graphics 

deleting, 48 
formatting, 58, 59 
inserting, 48 
moving, 56 
resizing, 56, 57 

Grid 
displaying, 69, 70 

Gridlines 
displaying in charts, 35, 36 
formatting, 36, 37 

Importing 
Excel charts, 31, 32 

Insert Clip Art task pane, 49 
Keywords 

assigning to clips, 62, 64 
Legends 

repositioning, 25, 26 
Lines 

color, 76 
drawing, 75, 76 
formatting, 76, 77 
styles, 76 

Microsoft Graph, 16, 23 
Objects 

aligning, 83, 84 
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applying 3-D effects, 74 
applying a shadow, 74 
applying fill effects, 72 
changing the fill color, 71 
drawing, 67 
drawing enclosed, 68, 69 
flipping, 81, 82 
grouping, 84, 85 
rotating, 80, 81 
stacking, 82, 83 
ungrouping, 84 

Organization charts 
adding position shapes, 90, 91 
adding text to shapes, 89 
creating, 87, 88 
formatting shapes, 94, 95 
rearranging shapes, 92, 94 
selecting multiple shapes, 92 

Pictures 
cropping, 54, 55 
inserting, 53, 54 

Pie charts 
exploding, 28, 29 

Presentations 
using charts, 16 

Rotate handle, 48, 80 
Rows 

changing height, 10, 11 
inserting, 12 
selecting, 11 

Shadows 
applying, 74, 75 

Sizing handles, 48 
Snap-to, 69 
Stacking objects, 82, 83 
Table AutoFormat 

using, 6, 8 
Tables 

adjusting cells, 10, 11 
changing column width, 10 
changing row height, 10 
creating, 2, 3 
editing an embedded Microsoft Word table, 5 
inserting columns, 12, 13 
inserting from Microsoft Word, 3, 4 
inserting rows, 12, 13 
linking a Microsoft Word table, 13, 14 
selecting columns, 11, 12 
selecting rows, 11, 12 
using Table AutoFormat, 6, 8 
working with user-defined table styles, 8, 10 
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Task pane 
Insert Clip Art, 49, 61 

Text 
adding to charts, 44, 45 

Text boxes 
creating, 77, 78 

Thumbnail, 61, 62 
 


